# OrganAssist Version 3.0
## User Manual

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>4</td>
</tr>
<tr>
<td>Installing on Windows</td>
<td>5</td>
</tr>
<tr>
<td>Installing on macOS</td>
<td>5</td>
</tr>
<tr>
<td>Selecting an Organ</td>
<td>6</td>
</tr>
<tr>
<td>Setting up the MIDI Connections</td>
<td>7</td>
</tr>
<tr>
<td>Connecting your console (Windows)</td>
<td>7</td>
</tr>
<tr>
<td>Connecting your console (macOS)</td>
<td>8</td>
</tr>
<tr>
<td>Connecting to Hauptwerk (Windows)</td>
<td>10</td>
</tr>
<tr>
<td>Connecting to Hauptwerk (macOS)</td>
<td>12</td>
</tr>
<tr>
<td>Testing the Equipment</td>
<td>15</td>
</tr>
<tr>
<td>Recording</td>
<td>16</td>
</tr>
<tr>
<td>Playback</td>
<td>17</td>
</tr>
<tr>
<td>Tip – You can Reset the organ from the menu if there is any problem</td>
<td>17</td>
</tr>
<tr>
<td>Editing Tracks</td>
<td>18</td>
</tr>
<tr>
<td>Editing the whole track</td>
<td>19</td>
</tr>
<tr>
<td>Margins</td>
<td>19</td>
</tr>
<tr>
<td>Editing Notes</td>
<td>20</td>
</tr>
<tr>
<td>Editing Stops</td>
<td>22</td>
</tr>
<tr>
<td>Adding Stops</td>
<td>23</td>
</tr>
<tr>
<td>Editing Expression/Volume Changes</td>
<td>24</td>
</tr>
<tr>
<td>Editing Sections</td>
<td>25</td>
</tr>
<tr>
<td>Changing Tempo</td>
<td>26</td>
</tr>
<tr>
<td>Creating Hymn Verses</td>
<td>27</td>
</tr>
<tr>
<td>Importing and Exporting MIDI Files</td>
<td>28</td>
</tr>
<tr>
<td>Importing/Exporting MIDI for the current organ</td>
<td>28</td>
</tr>
<tr>
<td>Importing General MIDI files</td>
<td>28</td>
</tr>
<tr>
<td>Importing Musescore MIDI Files</td>
<td>30</td>
</tr>
</tbody>
</table>
Advanced MIDI Configuration ................................................................. 54
System Requirements ............................................................................... 55
Performance .......................................................................................... 55
The Future ............................................................................................... 55
Introduction

To understand OrganAssist, it is important to know that it is maintained as a personal project when time allows. Some parts are very easy to use. Some aspects are more challenging and so it may not be suitable for everyone.

Priorities

The main priorities are:

1) It must be able to record multiple pieces performed on an organ console with NO user action on the computer (i.e. during a church service)

2) All recordings must be easily playable on this and all current or future organs regardless of specification and MIDI implementation.

3) It must provide some simple editing of recordings to delete/amend wrong notes, delete/move/add stops and alter the tempo.

All other features (Playlists, Library, etc.) are secondary and may not be as easy to use. OrganAssist was developed more than 15 years ago, and so some of the user interface is "dated" and not consistent with modern practice.
Installing on Windows

To install OrganAssist on Windows, download the Full Installer from the website downloads page. This is a standard Windows installer and will work on all versions of Windows from XP SP3 through to Windows 10

**Windows SmartScreen Warning**
As an independent developer I do not have the resources to certify the OrganAssist program installer. If you are using a recent version of Windows you may see a warning message “Windows Protected your PC” when you try to run the installer. If you click on “More Info” and then click on “Run Anyway”, OrganAssist should install correctly.

If you wish to restore an earlier version, using Control Panel, Add/Remove Program (or Programs and Features) to see the list of installed software and click to remove the OrganAssist Update. You will then need to either Repair the OrganAssist Full Install using the options in this window.

Installing on macOS

To install OrganAssist on macOS, you will need to download and install TWO applications. Both are available on the website download page.

**IMPORTANT** – You should move both apps out of the Downloads folder to another location (Desktop, Applications etc) BEFORE you attempt to run them for the first time. To run the first time you will need to Command + Click or Secondary Click to allow you to authorise the installation.

In addition to the OrganAssist application you will need to install the OrganAssist MIDI Helper program. This is required due to a limitation in the software that wraps OrganAssist so it can run on macOS. This Helper application handles all incoming MIDI data to ensure that nothing is lost.

OrganAssist has been packaged so that the application only has access to your Documents folder. All the working OrganAssist files will be created in an OrganAssist folder within Documents.

**Technical Note** – There is an additional folder created on first run in the standard location Home/Library/Application Support. This folder will be named com.organassist followed by a long number. This holds a copy of all the application files but none of the files you create.
Selecting an Organ

When you first start OrganAssist you will be presented with a list of available organ configurations.

Choose an organ and click on Select to load it.

You can tick a box to automatically use this organ as the default next time.

You can also tick a box to prevent prompts when loading the organ (for example reminding you that all stops must be off when loading).
Setting up the MIDI Connections

Refer to the relevant section below to set up the MIDI on your configuration.

Connecting your console (Windows)

When you first run OrganAssist, the second screen you see is required to configure the MIDI connections.

It can also be accessed via the menu – Tools, PC MIDI Setup.

More than one MIDI input can be ticked but only one output is used.

You can clear the checkbox to stop this window appearing next time you start OrganAssist.

IMPORTANT – Before continuing you should test your hardware using the built in MIDI recorder on this screen. See the section below on Testing the Equipment
Connecting your console (macOS)

Configuring OrganAssist on macOS involves 2 steps.

First you need to create a virtual MIDI cable to connect the OA MIDI Helper app to OrganAssist. On macOS this feature is provided as standard and can be configured via the Audio Midi Setup application (which is found in the Applications, Utilities folder).

Select Window, Show MIDI Studio and then click on IAC Driver (macOS refers to Virtual Midi Cables as IAC Bus).

Ensure that the checkbox is ticked to ensure the Device is online. You just click on the + plus sign at the bottom left to add more devices. For connecting to an external console you only require one IAC Bus/Virtual Cable.

Once you have added / enabled this you can run the OrganAssist Helper program. You should select the output from the console on the left and an IAC Bus on the right (to send the MIDI data to OrganAssist).
Click on the Connect button – the program will wait for OrganAssist to be started. Once a connection is established the program will minimize as no further action is required. The program will connect automatically the next time you run it.

Now you should run OrganAssist and set the MIDI Input to be the IAC Bus you selected on the right in the Helper program. (Note that, on macOS, the MidiMate connector is just identified as Port 1, Port 2)
Connecting to Hauptwerk (Windows)

When using OrganAssist with Hauptwerk, it is best to use the loopMIDI utility, kindly written by Tobias Erichsen. All you need to do is create several virtual MIDI cables by typing in a new name and clicking on the + button. For clarity, name the cables. For example “Hauptwerk to OrganAssist” and “OrganAssist to Hauptwerk”.

In Hauptwerk, go to the General Settings menu and click on MIDI Ports. In the MIDI IN ports tab, in the right hand SEQUENCER column, click on a loopMIDI port (i.e. “OrganAssist to Hauptwerk”)
Now select the MIDI OUT ports tab at the top. In the right hand SEQUENCER column, click on a loopMIDI port (i.e. “Hauptwerk to OrganAssist”)

Click on OK to save these settings and run OrganAssist and choose the organ layout. The second screen is required to configure the MIDI connections.

In OrganAssist you must connect the Hauptwerk output i.e. “Hauptwerk to OrganAssist” as the Organ IN.

The Organ OUT from OrganAssist must connect to the Hauptwerk input i.e. “OrganAssist to Hauptwerk”
Connecting to Hauptwerk (macOS)

To connect to Hauptwerk you will need 3 Virtual Midi Cables. This feature is provided as standard in macOS and can be configured via the Audio Midi Setup application (which is found in the Applications, Utilities folder).

Select Window, Show MIDI Studio and then click on IAC Driver (macOS refers to Virtual Midi Cables as IAC Bus).

Ensure that the checkbox is ticked to ensure the Device is online. You just click on the + plus sign at the bottom left to add more devices. For connecting to Hauptwerk you will require three IAC Bus / Virtual Cables.

In Hauptwerk, go to the General Settings menu and click on MIDI Ports. In the MIDI IN ports tab, in the right hand SEQUENCER column, click on an IAC Bus — in this example No 1.
Now select the MIDI OUT ports tab at the top. In the right hand SEQUENCER column, click on an IAC Bus – in this example No 2

Click on OK to save these settings. Now run the OA Midi Helper application to route the output from Hauptwerk into OrganAssist using the third IAC Bus like this. Click on the Connect button. Once the connection to OrganAssist is established this window will automatically minimize as no further action is required. The program will automatically connect the next time you run it.
Run OrganAssist and configure the MIDI Input to be the IAC driver on the right in the Helper Program. Configure the MIDI Output from OrganAssist to connect to the Input in Hauptwerk – in this example No 1
Testing the Equipment

It is important that, before you configure OrganAssist, you test that the equipment you are using is working correctly. On the PC Midi Setup screen is a Record button. Press this button to try setting some stops and recording a few notes and then click on Stop and then click Playback.

This recorder bypasses ALL logic in OrganAssist and only plays back exactly the MIDI data it receives.

If Playback does not work correctly you will need to resolve this problem before configuring OrganAssist as there is a problem with either the organ, the MIDI cables or the way you have selected the MIDI inputs and outputs.
Recording

OrganAssist provides the easiest possible way of recording, since it intelligently starts and stops tracks – including storing information about the current registration. Once it has been installed and configured for a particular instrument, the only action required is to click on single button.

At the bottom of screen is a recording and playback control that works in the same way as a tape recorder.

Just click on the button to start recording.

OrganAssist monitors all activity on the console and, once the first note is played, it starts recording a new track. It automatically includes at the start of this track any stops that are currently on.

Once a piece is finished (that is, OrganAssist detects no notes are playing for at least 4 seconds) it then saves the track and continues monitoring. You can then take time to change stops etc. and then, when you start playing again, OrganAssist automatically starts recording another track (again including the current stops).

It is possible to record every individual piece over long periods of time, for instance an entire service. Each track is saved individually with the date/time as the filename.

When you have finished playing all the pieces you want to record, click on the button to Stop.

The new pieces will appear in the drop down box in the bottom left corner of the screen. You can easily select one and click on the button to hear your recording.

Also, if you look at the Library you will find the track listed in more detail.

If, in a recording session, you wish to also playback tracks you can use the Background Recording option on the Tools menu. This will only record what is played at the console. This will automatically stop if you edit a track.
Playback

You can select a track to play in two ways. In the Library screen you can click to highlight a track. Double click will start playing it.

Or on any screen, in the bottom left corner, use the drop-down list to select a track.

Using the playback control at the bottom centre of the screen, you can click on the play button to hear the track. You can use the fast-forward and fast-rewind buttons move through the track (while still hearing the music). You can press to pause. The buttons and move you to the start of the Previous or Next track in the list.

TIP – When paused - to restart playback you must click on the Pause button again to “release” it. This works in the same way as an old tape recorder.

Pieces recorded using OrganAssist will play back exactly as recorded if played on the same instrument. However, when playing on a different organ, OrganAssist will automatically select the most appropriate stops.

Tip – You can Reset the organ from the menu if there is any problem
Editing Tracks

The editor allows you to correct, insert or delete notes. You can move or delete stop changes. You can insert stop changes by playing the piece and then changing the stops.

To edit a track, go to the Library form, Right Click on the track and select “Edit Track” from the menu.

This will display the track in a scrolling window with a “Piano Roll” format.

TIP – You can begin playback at any point in the track using the scroll bar and then either pressing the Play button or double-clicking exactly where you want to start.
Editing the whole track

You can use the File menu to Save a copy of this track as a new name.

You can use the Edit menu to Transpose the entire track up or down 1 semitone.

You can change the Margins of silence at the start/end of the track. These appear as a “white note” between the stops and the top of the keyboard area. You can drag the end of the Margin to make it longer or shorter. The default margins for the current organ can be set via the Library, Edit menu. These will then be used whenever you record or edit a piece for the first time. The default margins can be set for each individual organ.

Margins

A new feature in version 3.0 allows you to adjust the amount of silence between the start of the track (when the stops are set) and the first note. In the same way you can adjust the amount of silence after the last note.

This feature is provided so that if you are making an audio recording, the noise of the stops being set/cleared is separated from the piece.

You can set the default margins for an organ from the Library, Edit menu. These values will be used for any recording for this organ or the first time a track is edited if from an earlier version of OrganAssist.

You can adjust the margins of a piece in the Edit Track screen. The margins appear as a “White Note” located above the top of the keyboard (just under the area displaying stop changes) at the start and end of a piece.

To change the Start Margin, click and drag the right end. To change the End Margin, click and drag the left end. You can set margins to be between 1 and 15 seconds long.
Editing Notes

Changing Single Notes

Individual notes can be editing by dragging them to a new position.

To change the pitch of a note click in the middle and drag it vertically, the start time of the note will remain fixed.

To change the start time of a note, click in the middle drag it horizontally, it will remain at the same pitch.

To change length of a note click and drag either the left or right end of the note.

To move the note to another keyboard, right-click and select “Move Note” from the menu and you will be given a list of keyboards to choose from.

Adding New Notes

New notes can be created by holding down the left mouse button and dragging. When you release the button you will be prompted to choose the keyboard/division this note should be played on.
Changing Multiple Notes

You can change multiple notes by clicking and dragging to highlight a section of the music. If you click and drag in the top margin, it will highlight the entire window from top to bottom. If you click and drag lower down, you can highlight a smaller section of the music.

You can then right-click to Delete the notes or Copy them so that you can Paste the selected notes at a different point in the track.

Your can also Move or Swap the selected notes with another keyboard. This feature is particularly useful when importing General MIDI files.

Undo Edits

By clicking on the Edit menu you can Undo edits. OrganAssist allows you to undo multiple edits if required.
Editing Stops

The stops used during a track are displayed as yellow markers at the top of the window. If you point at any marker, it will display the stop name.

To Delete a Stop Change, right-click on it.

To Move a Stop Change to a new position, click and drag it.
Adding Stops

To make more extensive changes to the registration in the Edit window, just click on the Play button in the Playback control.

While the track is playing you can change the stops using the OrganAssist organ window.

When you press Stop or Pause the new stops you have added are displayed in the top area of the edit window.

Although you cannot actually create a stop change via the Edit window, you can move it, delete it or record additional stops changes to replace it.

TIP – To add additional stops at the start of a track, press the PAUSE button. OrganAssist will position the track at the start of the first note and pause so that you can add/change stops. You can then either press Stop to add these immediately or Play to continue.
Editing Expression/Volume Changes

In the top area of the Edit window, in addition to the stop markers, is a line indicating the position and movement of the expression pedals.

This cannot be edited directly but, during playback you can move the volume slider next to the keyboard on the Organ screen to modify its position. These movements are relative and so, if you increase the volume, it will be increased from this point onwards.

To change the volume for part of a track you can play this section, modifying the volume at both the start and end of the section. If it is long section you can start playback, adjust the volume and press stop. Then you can scroll to the end of the section, double click to start playback, adjust the volume and press stop.


**Editing Sections**

By clicking and dragging in the top area of the Edit window (not on an existing marker) you can highlight and select part of the track.

By right-clicking on this selection you can take a number of actions. You can Copy or Delete the selection (optionally retaining Stop changes).

If you Copy a selection, you can right-click to Insert this elsewhere in the track. If you change to a different track, the selection is preserved and can be Inserted anywhere. This allows you to create a single track from several different recordings.

You can also choose insert a blank time span of this duration into the track.
Changing Tempo

To make it easy to navigate within a track, you can fast forward or change the tempo. Normally these actions do NOT affect the saved track.

By clicking on the Edit menu at the top of the window you can choose to Include Tempo Changes.

You can change the Tempo using the slider at the bottom of the window. Press the Play button to start playback.

If this is the only change you require you can then press the Stop button and the whole track will be processed to reflect the new tempo. This is because when you press Stop, OrganAssist assumes that you want the Tempo to stay the same as the current setting for the rest of the track.

If required, during playback, you can move the slider to vary the tempo during the track. All these changes will be saved when you press Stop.
Creating Hymn Verses

You can add Verse markers to a track which makes it possible to change the number of verses during playback.

In the Edit window, if you right-click at the start of the first verse (after the introduction), you can add a verse marker. Repeat this to add a Verse marker at the start of each verse.

Verse markers can be moved in the same way as Stop markers. They should be placed at a point where no notes are sounding.

Now, at the bottom of the window, next to the duration, there is a verse counter. By clicking on the up and down arrows you can select a different number of verses. During playback, OrganAssist will start with the introduction and first verse, it will then omit or repeat verses as required and finish with the last verse. As it progresses it will display the current verse and the total selected (i.e. 2/4).
Importing and Exporting MIDI Files

OrganAssist has a number of options for importing/exporting various forms of MIDI file which can be found in the Library File menu.

Importing/Exporting MIDI for the current organ

For organs that are already configured in OrganAssist, you can import / export MIDI files preserving all registration and expression. This can be used, for instance, to import files recorded in other software such as Hauptwerk.

A unique feature of OrganAssist is that it is capable of recording a long session involving a number of individual pieces, and then saving these as separate files complete with all registration and expression. This feature is now available for imported MIDI files.

TIP - If you import a MIDI file for the current organ, this is analysed and, if it contains multiple pieces, you are prompted to choose what actions you wish to take. This can automatically divide the recording into individual tracks and, if you choose, automatically re-export them for use with other software.

Importing General MIDI files

One of the difficulties of MIDI is that there is no agreed standard for the channels that are used for different keyboards. OrganAssist can import standard MIDI files and, after analysing the use of MIDI channels, it displays a screen to allow you to choose which MIDI channels are assigned to which keyboard on the organ.

To assist you in this choice it analyses the pitch range and polyphony of the MIDI notes. This information indicates which channel might be the Pedal and which the manuals. To aid this process, there are drop-down lists to select the keyboard and it is possible to assign multiple MIDI channels to the same keyboard if required.

General MID files sometimes contain the same notes on multiple channels to playback several sounds for a particular part. These extra channels are not required when importing for an organ as several stops can be selected to achieve the same effect.

Below is an example of the MIDI Import Settings window during the import of a MIDI file of a Bach chorale.
From the information displayed it is clear that channel 1 contains the tune since the pitch is too high for the pedals and the polyphony indicates it is a solo line. Channel 2 has a higher polyphony indicating either chords or multiple parts so this is the accompaniment. Channel 3 contains the pedal line since the range of note pitches fits on the pedalboard and it is a solo line. Channel 4 is an exact duplicate of channel 2. This indicates it is a second voice in the general MIDI file that is not required on the organ.

Using the drop-down lists you can then choose the correct division/keyboard for these notes like this. In this case I have chosen to play the tune on the Swell and accompaniment on the Choir.

If you have Exported this file from OrganAssist to edit using other software, then during the import you can choose to use the Export Settings button so that the file is imported to the original divisions/keyboards.
Importing MuseScore MIDI Files

MuseScore is a very useful, and free, score editing program. However the current version (at February 2018) does not export MIDI files in a format that is easily used on an organ.

If the score uses either Organ or Pipe Organ as the instrument then ALL notes for this instrument are output on the SAME Midi channel. This means that all the notes would go to the same keyboard. An additional problem is that, if the instrument is set to Pipe Organ, the pedal line is stored at 16 foot pitch, with the MIDI notes set to one octave below the pitch on the visible score. This means that these notes would be lost or played one octave too low when played back on a standard organ.

OrganAssist has special logic to deal with these problems. When you select a MIDI file to be imported there is a checkbox on the form to indicate this is a MuseScore Midi file. OrganAssist then processes the file and assigns the top stave to MIDI channel 1, the middle stave to Midi channel 2 and the bottom stave to Midi channel 3. OrganAssist also analyses the pitch of the pedal line and transposes it up one octave if required. This all happens automatically.

You can choose which keyboards the individual staves are sent to in the same way as for General Midi files.

The settings you use for MuseScore are saved indipendently from the settings for General Midi so that they are used as the default for future MuseScore imports.
Splitting MIDI Tracks

OrganAssist version 3.0 provides a new feature to import/export existing MIDI tracks splitting them into individual pieces. If you import a track for the Current Organ then OrganAssist analyses it to see if there are a number of separate pieces. If it contains more than one piece you are given the option to split the track:

If you reply yes then, before splitting the track you can set the Margins of silence:

After splitting and importing the track you can choose to re-export these individual pieces in the same MIDI format:

Finally, if you do not intend to use these tracks in OrganAssist, you can choose to delete them from the OrganAssist library.
Backup Entire Library as MIDI

This is a new option in Version 3.0 and is located in the Library, File menu.

If you select this item, OrganAssist will go through the ENTIRE library of music and export every track as MIDI for the Current Organ. These MIDI files will be stored in a folder called Backups/Organ-Name in the default Music folder. This process will delete/overwrite any existing files in the backup folder for this organ.

This feature has been provided so that if, at some point in the future, OrganAssist is no longer able to run on the latest version of Windows/macOS, you can transfer all your recordings as standard MIDI files for use with other programs.

It is clear that both Windows and macOS are moving to a new standard and may cease supporting existing 32 bit applications. Should this happen, OrganAssist will continue to work on existing/earlier versions of both operating systems but will not be re-written as it contains over 40,000 lines of code!
Creating new organ layouts

A number of different makes and models of organs are provided with OrganAssist. You can use one of these as the basis for a new layout.

TIP - It is usually easier to select an existing layout that has a larger specification and delete stops you do not need. For this reason a “thumb-nail” of the organ layout appears when an organ is highlighted in the list for loading.

Configuring an organ can take some time – allow at least one hour for every 40 stops you need to configure. (Setting up PAB Gravissimo took nearly 4 hours)

Use the menu to go to Tools, Edit Organ Layout.

Once the Edit Organ Layout panel is visible - change the Organ Name (which is the name that appears in the list of organs). Also choose a different file name. Now select “Save As” from the top menu to create a copy.

Once you have created the copy, it is important to change the Manufacturer (if necessary). This affects the both way OrganAssist processes information and also the options that are available. This setting can be changed later if necessary.
Getting started

When you have copied an organ, and before setting it up, you should click on the “Clear ALL MIDI data” button, since the information from the previous organ will not be valid for the new one. This avoids any confusion.

It is best to create the layout of the screen first by creating, moving and deleting stops. Once the layout is correct you can then complete the configuration by selecting the correct Equivalent for each stop and learning the MIDI.

Adding a new Stop or Keyboard

Right-click on the background of the organ and select the item you wish to create. OrganAssist creates a new stop by copying the nearest one.

You can click on any item to select it. It will be highlighted by a red border.

Tip – Create any keyboards first as the Stop Equivalent list will only include couplers for existing keyboards.
Moving and Resizing Items

The top-left corner of any item is used as its position on the screen. If you point at the top left corner of a selected item, the cursor changes to a four-way arrow. If you click and drag, you can move the item.

If you point at the bottom left corner of a selected item, the cursor changes to a diagonal arrow. If you click and drag you can change the size.

If you right-click on an item you can Delete it.

**TIP – Save the edited layout regularly while editing to avoid losing your work**

If you click on a stop you can change the name that appears on it by typing the name in the text boxes provided on the Edit Organ Layout floating panel. See the Configuring the Stops section of this manual for more details.

Do not spend a lot of time on the exact positions as there are tools to help with this.

Deleting Items

You can delete individual items on the screen by right-clicking on them. Also you can delete groups of stops by highlighting them as described below. There is a new option on the menu to Delete Selected Stops.

Moving and Aligning Groups of Stops

To align a selection of stops, click and drag to draw a rectangle surrounding them.

You can move all stops in a rectangle by dragging the top-left corner of the rectangle.

You can “zoom” the selected stops by dragging the bottom-right corner. This only affects the position but not the size of the stops.

To align the stops in regular row and columns, right-click within the highlighted rectangle. If you right-click within this area, you can also “Auto-align Stops”. You can choose three options. Diagonal – if the stops are arranged as in this example. Grid / Terraced – if the stops are round and placed in horizontal row or columns. Tab – if the stops are rectangular and in rows.
TIP – You can temporarily hide the keyboards to give more space on the screen for moving stops around during editing. Just click on the Edit, Hide Keyboards menu item.

Below is the result of aligning these stops as Diagonal.

TIP - the rectangle only needs to include the top-left corner of a stop in the highlighted area to include it in the process.
Make all stops the same size

If you right click on a stop and select “Size all similar”, it will change all similar stops to the same size (only round if this stop is round, only rectangular if this stop is).

Using the (slightly larger) Fifteenth 2 stop above as an example. This is the result of Size all similar:

![Organ Diagram](image)

**TIP** – Although there is an Edit Undo/Redo feature - regularly save the layout so that you can restore a previous version if you accidentally make a change you regret or that “breaks” the configuration.
Configuring the keyboards

You can configure organs with up to 5 manuals. The order they are created reflects the English convention. Pedal, Great, Swell, Choir, Solo and Echo. These represent the role of the manual regardless of its location in relation to the other keyboards. So in an English configuration, the Choir is located under the Great. In a French configuration the Great will be located at the bottom.

You can re-position and rename manuals. The names you choose will automatically update the names of all couplers listed in the Equivalent stop list that identifies the role of each stop.

The Equivalent stop list will only contain couplers relevant to the current configuration. If you add another manual, additional couplers will appear in the list.

When editing the organ layout, the Lowest and Highest text boxes that appear for each manual, represent the MIDI number of the bottom and top notes. You can change these as required.
Configuring the stops

It is necessary to configure each stop correctly. Click on a stop and look at the Edit Organ Layout floating panel.

TIP - You can move sequentially through all the items on the screen using the Page Down and Page Up keys.

To set the visible name of the stop, type this into the 3 name files. The Full Name field is the “tooltip” text that is display when you hover the mouse pointer over a stop.

TIP - If you delete the Full Name field, it will automatically be created using the information in the 3 Name fields above.

Not only is it necessary to set the Name of the stop – it is important to correctly configure the Division and the Equivalent.

The only information OrganAssist stores in a recorded track, is the Division and Equivalent of each stop change. These must be unique within this organ. If these
are set incorrectly a track will still play correctly on THIS organ. However, the registration will be incorrect if played on a different instrument.

The equivalent includes a long list of Stops (arranged by pitch) and includes all couplers relevant to this instrument. You can move through this list using the Up and Down cursor keys. You can move directly to a stop by typing the pitch and the first few letters. “16b” takes you to the first 16 foot stop starting with B. “CG” takes you to the first Coupler starting with G. You can then browse this area of the list.

**TIP - Only select Tracker couplers if your instrument actually moves coupled notes OR requires / sends MIDI messages for coupled notes. These enable OrganAssist to automatically generate the additional notes required during playback. Most instruments (and Hauptwerk) do NOT require this option. Always try using standard couplers first.**

You can set the Text Colour and set the shape to Round or Rectangle. You can invert the colours so that the stop has white text on you selected colour background.

There are two other fields on this panel. “Repeat ms” and “Delay ms”.

The Repeat ms value (thousandths of a second) is used to prevent OrganAssist from sending conflicting messages too quickly to a moving draw-stop. If a Stop ON and Stop OFF message are sent together then some moving draw-stops will ignore the second message. OrganAssist will wait for this amount of time before sending the second message. This only affects 2 conflicting messages to the SAME stop. It has almost no impact on normal playback.

The Delay ms (thousandths of a second) adds a delay AFTER this stop has been changed. This is useful if a particular feature takes some time to activate. This delay is always added after the stop change before OrganAssist continues playback. This should normally be set to 0.

These two features were included since some early digital organs did not buffer MIDI correctly and so OrganAssist had to pause slightly to avoid data being lost.

**TIP – All Repeat and Delay values should be zero unless you find a specific problem that needs correcting. Non-zero Delay values can adversely affect playback.**
Learning the MIDI

If you click on the Record/Set ALL MIDI button on the Edit Organ Layout panel, OrganAssist will prompt you so it can learn the MIDI data for each item.

First it will prompt you to play some notes on each keyboard.

Next it will prompt you to move each expression pedal fully open and closed several times.
If you do not have expression for a division (for example – Pedal) then click on the Cancel button and then click Yes to continue with the next item.

It will then prompt you for to switch ON and OFF every stop in sequence:

Once this process is complete, save the configuration. Any potential problems will be listed (a common example that is NOT a problem – No MIDI data for Pedal Expression).

If you wish to re-configure the MIDI for a single item, just right-click on it and choose Set Midi.

If OrganAssist is unable to “learn” the data automatically, if you are familiar with MIDI codes, you can use the PC MIDI Setup window to view what codes are sent by the console and then using the Edit Organ Layout panel (after ticking the “Edit MIDI” box) you can type the codes in manually.

For information on Configuring Hauptwerk organs, please see the next section of the manual.

For more information about entering MIDI codes by hand, please refer to Advanced MIDI Configuration in the Technical Details section of this manual.
Configuring Hauptwerk

OrganAssist comes with many organs pre-configured for Hauptwerk 4.2

If new organs are contributed then these will be made available on the Download page of the OrganAssist website.

Creating new organ layouts for Hauptwerk is only for more advanced users.

The process to configure a new organ is identical to that described in the previous section with some minor additions.

Hauptwerk organs often have multiple screen views (Console, Left Jamb, Right Jamb, Stops/Pistons etc). The way in which the organ has been created in Hauptwerk can mean that the stops on these different screens use different MIDI messages. When using the MIDI set process (either for a single stop or for the entire organ) in Hauptwerk, OrganAssist does NOT delete the previous data but adds it into the next free field. OrganAssist can cope with up to 4 different MIDI messages to set a specific stop. These can be a mixture of different types (NRPN and SYSEX) and OrganAssist learns them in the usual way.

Note that Thumb and Foot pistons, Crescendos and Tutti pistons may also use different messages. It is important that OrganAssist is configured so that it recognises ALL the different ways in which a stop can be set in Hauptwerk.

To teach OrganAssist the codes used by a Crescendo it is necessary to clear the first few levels of the Crescendo and then select a single stop. Right-click on the stop in OrganAssist to Set the Midi. Now slightly open and close the Crescendo to switch the stop on and off. This process must be repeated for each stop in the Crescendo.

For Tutti (or other non-standard pistons) a similar approach is required to activate each stop in turn so that OrganAssist can learn the correct MIDI message.

Below is the configuration for the Great to Pedal coupler of the St Anne’s Moseley organ that is provided with Hauptwerk.

This stop requires 5 different messages.
MIDI 1 is the message when moving the stop
MIDI 2 is the message when activated by the Crescendo
MIDI 3 is the message when moved by the Thumb Piston
MIDI 4 is the message when moved by the Foot Piston
MIDI 5 is the message when moved by the FF Thumb Piston
The 5 MIDI fields each have 2 sections.

The first section contains the MIDI message with a special “marker” (FF) that shows which position in the message changes to indicate On or Off.

The second section shows the information that is found in this position when a stop is switched On or Off. OrganAssist recognises and generates the correct MIDI messages based on these two pieces of information.

MIDI 1 shows a single set of NPRN messages that are received to switch the stop On or Off. MIDI 2 shows the single SYSEX message that switches the stop On or Off.

MIDI 3 and MIDI 4 are different as the pistons send 2 messages each time they are pressed. These do not indicate On OR Off but that the stop reverses position. To indicate that this is a “Double” message, OrganAssist puts “FD” to mark the position of the data that changes (instead of FF). It will then respond to the first message of each pair, reversing the position of the stop.
Playlists

Playlists are provided to enable anyone to run a complete service just by pressing the space bar. Click on Playlist and then create a new file.

![Select Playlist](image)

After choosing the default template (Blank) you then can edit this new playlist.

Inserting Tracks

Tracks are inserted from the Library into the Playlist. You can right click to insert the selected track from the library. This feature is available in both the Library and the Playlist. Therefore you can select and insert a number of tracks from the Library and they will be inserted in order into the playlist starting at the selected position.
Customising Playback

You can edit the first 2 columns to add descriptions to the playlist if required.

By default, if the Delay field is blank then OrganAssist will wait for the Space Bar (or Play Button) to be pressed before playing a track.

If you enter any number into the Delay field, it will wait for that number of seconds and then start playing this track automatically.

The Verses field can be used to pre-select the number of verses in a hymn.

The example playlist below will play 2 preludes with a 5 second gap and then wait for the play button before playing 2 out of 3 verses of the hymn. It will then wait for the play button before playing the final track.

If a track is edited after being included in a playlist, then it must be re-inserted as the playlist will not recognise the amended track. This is a safety feature to prevent you accidentally playing an edited track in a service without knowing it.

Repeat / Shuffle

You can tick the boxes to either Repeat or Shuffle the tracks in the playlist. This may be useful if you create a playlist of background music.
User Options form

Here you can change the default Folders for music, organs and playlists. You can also set the background image for an organ and also set this as the default.

You can Select the interface language. All the text required for each language is stored in a text file in the \My Documents\OrganAssist folder. These Language text files contain instructions on how to amend them to provide new languages.

You can change the delay between pieces so that OrganAssist, while recording, will wait for a different time period before starting a new track.

Since OrganAssist sets the stops immediately before (and after) playing, this can cause noise when trying to save an audio recording. If this option is ticked, OrganAssist will always pause before the first note of a piece and again after the last note. Pressing the PAUSE button again resumes/finishes the playback. **This option should be used during Audio Recording only.**

By default OrganAssist attempts to ignore MIDI feedback. If you find that there are problems with OrganAssist ignoring MIDI input – try disabling this feature.

You can default the Master Volume to a specific value if this is supported on your model of organ.
**Supported Manufacturers**

Since there are so many different models and configurations I cannot guarantee that OrganAssist will work with every instrument. However, if you find any problems, please contact me and I will do what I can to help. It is only as a result of the co-operation of other people that I have been able to provide support for so many different systems.

If there are any manufacturers that I have missed, and you would like to help add them, please contact me. OrganAssist continues (in 2018) to be a work in progress.

**Generic Organ**

This option uses general purpose logic that is not customised for any specific manufacturer. If your organ manufacturer is not among those listed below, you should first try choosing Generic Organ to see if this works.

**Allen – Limited Support**

It is possible to configure Allen instruments as OrganAssist can “learn” individual stops correctly.

Playback of existing recordings should work correctly.

There is only limited support for recording music as the combination pistons do not transmit information about the stop changes. Recording of performances using stops registered “by hand” should work correctly.

Alternative voices may produce unpredictable results.

**Classic Organ Works**

It is possible to configure instruments using Classic Organ Works systems by learning the stops in the usual way.

However, to get Combination Pistons to work you must carry out the following additional steps as they use a different MIDI system than the stops. Unfortunately there is no shortcut – this needs to be done individually for each stop.
1) Set up a General Combination with just ONE stop
2) Set up a second General Combination with NO STOPS
3) Right click on the stop and select Learn MIDI
4) Press the first piston to set the stop
5) Press the second piston to clear the stop
6) Repeat this process for each individual stop

**Content**

OrganAssist has been tested with several Content organs and so should work correctly.

**Hauptwerk**

Hauptwerk Versions 4.0 to 4.2 are fully supported. Please refer to the earlier section on Configuring Hauptwerk in the Creating new organs section.

**Johannus/Makin**

Instruments by Johannus and Makin are fully supported.

Earlier instruments use a different system than later ones - so there are 2 options in the Manufacturer list.

If you are unsure – try configuring an instrument using the second option and if you encounter any problems, switch to the first one. If the wrong option is chosen, you will often find a problem that the General Cancel button does not clear stops correctly within OrganAssist.

**Peterson**

OrganAssist supports organs using the Peterson system.

**Rodgers**

Rodgers organs are fully supported in OrganAssist.
Solid State Systems

Organs using Solid State Systems are supported by OrganAssist. There are 2 MIDI systems. Type 2 is for the newer system introduced in 2010

Type 1 uses MIDI codes starting : F0 2B 01 01
Type 2 uses longer MIDI codes starting: F0 2B 01 02

Viscount

Viscount instruments should work correctly.

There can be issues with Tremulants due to the fact that some models include the speed/depth settings in the MIDI data. If the Equivalent of a stop is set to Tremulant, OrganAssist should cope with this complexity. If you never change the tremulant settings then, since the MIDI data is constant, there should be no problem.

Wyvern

OrganAssist has been tested with several Wyvern organs and so should work correctly.
Technical Details

By default, all files are stored in the \Documents\OrganAssist folder. Backups of editing tracks and organs are moved to a Backup folder within the default Music or Organs folder. These can be renamed with the correct file extension (.oae for tracks and .oao for organs) and moved back to the relevant folder if required.

This folder contains the OrganAssist.ini file that stores all the settings you choose (MIDI Ports, Organ Details etc.).

As stated above, this folder also contains some text files. These text file provide all the wording within OrganAssist (on buttons, menus, message boxes). There is one text file for each Language. These are listed on the User Configuration form.

The language text files contain instructions for anyone to easily create different languages. Please share any new languages to help others.

Restoring Backup Files

Recorded tracks are stored in the \Documents\OrganAssist\Music folder. Every time you make an edit a backup file is saved with the Date and Time in the filename and stored with a .bak file extension.

To restore the backup of a track, locate the backup file and change the file extension to .oae. When you restart OrganAssist, the track will appear in the Library.

Organ layouts are stored in the OrganAssist\Organs folder. As with recorded tracks, a backup is saved before every edit and stored with a .bak file extension.

To restore the backup of an organ layout, rename it to change the file extension to .oao. When OrganAssist is restarted, the organ will appear in the list. Since organs must not have duplicate names, unless you delete the current organ layout, one of the two organ layouts will have a suffix to make them unique.
Upgrading from earlier versions of OrganAssist

OrganAssist version 2.7 is a major upgrade from the previous stable version - 2.5. It includes a change in the file format for both organs and recorded tracks.

Any existing organ or track will be converted when it is loaded into OrganAssist 2.7. Version 2.5 music recorded on a specific instrument should play back unchanged on the same organ. However, due to a change in the list of Equivalents, it is necessary to check whether the stops on the organ are correctly set up for version 2.7.

To successfully upgrade existing files - add them into the correct folders. It is important that you add both the organ definition and any tracks recorded using this organ at the same time. If you then edit the organ layout to correct the Equivalents, OrganAssist will automatically edit any existing tracks (recorded on this specific organ) to match. OrganAssist uses the name of the organ (as saved in the track details) to locate any affected files and automatically converts them when you save the updated organ layout. If you add the tracks AFTER changing the organ configuration then they will not be updated correctly.

Using files from OrganAssist 2.7 with earlier versions of the program may result in unpredictable results.

Version 3.0 continues to use the same format. Recorded tracks are compatible with version 2.7 but some features may not be available if used with the earlier version.
How does it work?

OrganAssist can play any recordings on almost any organ (that has MIDI input) since it has been designed from the ground up to allow full portability of recorded music across all instruments.

Since different manufacturers (and even models) of organ can use different MIDI configurations, it is not possible to record MIDI from one instrument and play this back on a different organ. Therefore, OrganAssist only records three items of data - the change in position of a Stop, an Expression Pedal or a Note. Stops are categorised in a structured way (reflecting the division, pitch, tone etc.) so that a similar stop can be used in future.

When OrganAssist is in playback mode, it is calculating and generating all the MIDI data in real time to match the selected instrument (even when playing on the same instrument as the track was recorded on). It is only by doing this that it can cope with manual changes to registration during playback or rewind tracks while playing them. Rewinding involves completely different MIDI messages since everything is reversed.

OrganAssist uses a similar approach to “printer drivers” used in some operating systems. It has specific code for each manufacturer which, together with the information stored in the Organ Layout, enables it to “talk” to a specific instrument.

When playing a different instrument, you may have to compromise on the selection of stops depending on the specification of the organ. These decisions are made not on an individual basis but reflect both the capabilities of the organ as well as the demands of the performance.

To achieve this OrganAssist contains a "Virtual Organist" which makes all the decisions about how best to replicate the original performance using the available stops. These decisions may involve substituting or ignoring registration changes depending on the scope of the instrument.

These changes are done during playback and in real time. Every time a stop is changed the Virtual Organist considers the required registration as a whole, calculates what might be the best option on the current instrument and then makes any changes as necessary.

To avoid the possibility of not hearing anything at all, OrganAssist will redirect stops and notes for any non-existent manual to the Great.
This system has been developed using the expertise of several experienced organists and has been tested on many instruments. However, as each instrument is individual, there will be times when you wish to change the registration yourself. This can either be done by changing stops on the screen during playback or you can use the editing features of OrganAssist to amend the track and save your preferred registration.

**Advanced MIDI Configuration**

OrganAssist comes configured to support instruments from a number of different manufacturers. However there may be times when it will be unable to understand the MIDI data it receives when you are attempting to “learn” the MIDI.

On the Edit Organ floating panel is an Edit MIDI check-box. If you tick this, it allows you to directly type in the MIDI codes if required. For example “C5 23 1F”.

You can see the codes that your instrument is sending if you use the Tools menu to view the PC MIDI Setup screen. If you leave this open, it will display the MIDI codes as they are sent and received.

*If your manufacturer is not specifically listed, you could try setting the Manufacturer to Generic Organ* and see if the MIDI learn facility works. If not you could try viewing the codes and typing them in manually. Try a couple of stops to see the results. The fields marked Midi On and Midi Off are used if there are two different codes – one for On and one for Off. The Midi Toggle field is used if the same code is used for both purposes.

Some of the systems supported use very long and variable codes. For these systems OrganAssist only stores the relevant data. For example – The MIDI codes stored for Rodgers instruments are in the format “1A 40”. This information allows OrganAssist to identify the specific location of the relevant bit of information that is required to build a Rodgers SYSEX MIDI message (which is considerably longer and has to be created “live” as it involves the position of all other stops).

OrganAssist supports Hauptwerk 4 for all normal stop changes. However, when using crescendos that are configured as part of a Hauptwerk instrument, a second type of code is sent. OrganAssist is currently unable to learn these automatically, as moving the crescendo affects many stops simultaneously. The chapter on Hauptwerk contains brief instructions on how to do this manually but it is tedious work.
System Requirements

Windows
Microsoft Windows XP SP3, Vista, 7, 8 and 10
A MIDI Interface - either physical or a Virtual MIDI cable like loopMIDI
Minimum Screen Resolution 1024x768

Apple
OS X El Capitan to macOS High Sierra
A MIDI interface AND the configuration of the built-in IAC Driver
The OA MIDI Helper application is required to route incoming MIDI data

Performance

Any PC built within the past 10 years should be able to run OrganAssist since it was originally developed on a Pentium 200Mhz PC with 64MB ram.

Even though playback should be fine, the process of configuring larger instruments (greater than 40 stops) may benefit from a faster processor.

A stress test of OrganAssist on an Intel i3-3220 playing back the famous Widor Toccata at 200% tempo (using a different organ than the recording) produced the following results.

99.9% of notes were sent to the MIDI interface within 9ms of the recorded time. Maximum delay on any single note 79ms (due to a preceding stop change) 100% of stop changes sent within 90ms of recorded time.

In summary – OrganAssist is capable of playing back notes with a timing accuracy of much better than 1/100 of a second and stop changes with an accuracy of 1/10 of a second.

The Future

It is clear (in 2018) that both Windows and macOS will be moving to new standards and may cease supporting existing 32 bit applications. Should this happen, OrganAssist will continue to work on existing/earlier versions of both operating systems but will NOT be re-written - it contains over 40,000 lines of code!

Version 3.0 of OrganAssist contains a new feature (in the Library, File menu) to save the ENTIRE library of music as standard MIDI files for the current organ. This will help you move all your existing music for use with other MIDI software if necessary.